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Mode d’emploi

 

Nous vous remercions d’avoir choisi cet appareil.

Veuillez lire entièrement ce mode d’emploi pour assurer une utilisation sans problème. Une fois que vous avez ter-
miné sa lecture, veuillez ranger ce manuel en lieu sûr.
Toute forme de copie ou de transfert non autorisé de ce mode d’emploi en tout ou en partie est interdite.
Roland DG se réserve le droit de modifier les caractéristiques et l’aspect de ce produit sans avis préalable.
Toutes les informations de ce mode d’emploi ont fait l’objet de vérifications et devraient donc être correctes. Si vous 
remarquez néanmoins une erreur, veuillez nous en informer.
Roland DG décline toute responsabilité pour tout dommage direct ou indirect résultant de l’utilisation de ce pro-
duit, indépendamment de toute défaillance éventuelle. En outre, Roland DG décline toute responsabilité pour tout 
dommage direct ou indirect lié à un objet réalisé avec ce produit.

 

Roland DG CORPORATION
1-6-4 Shinmiyakoda, Hamamatsu-shi, Shizuoka-ken, JAPAN 431-2103
NOM DU MODÈLE: Voyez les données figurant sur l’étiquette de modèle.
DIRECTIVES S’APPLIQUANT À CE PRODUIT: DIRECTIVE CE POUR LES APPAREILS DE BASSE TENSION (73/23/EEC), 
DIRECTIVE CE POUR LA COMPATIBILITÉ ÉLECTROMAGNÉTIQUE (89/336/EEC).
ATTENTION: Ce produit est un appareil de classe “A”. Son utilisation dans le cadre domestique peut produire des interférences 
avec des récepteurs de radio ou de télévision. Dans ce cas, veuillez prendre les mesures adéquates.

CutStudio est une marque commerciale de Roland DG Corp.
Windows® est une marque déposée de Microsoft® Corporation aux Etats-Unis et dans d’autres pays.
Macintosh et Mac OS sont des marques déposées ou commerciales de Apple Computer, Inc. aux E.-U. et dans d’autres pays.
Adobe et Adobe Illustrator sont des marques déposées ou des marques commerciales de Adobe Systems Incorporated aux Etats-Unis et dans d’autres 
pays.
Corel et CorelDRAW sont des marques déposées ou commerciales de Corel Corporation ou Corel Corporation Limited.
Tous les autres noms de firmes et de produits figurant dans ce manuel sont des marques de fabrique ou des marques déposées de leurs détenteurs 
respectifs.
Copyright ©2005 Roland DG Corporation

 

http://www.rolanddg.com/
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Veuillez lire attentivement ce contrat avant d’ouvrir le sceau de l’emballage du disque L’ouverture du sceau de l’em-
ballage du disque implique l’acceptation des clauses du présent contrat. 
Roland DG Corporation (“Roland”) vous accorde une autorisation non transférable et non exclusive d’utiliser les 
LOGICIELS INFORMATIQUES contenus dans l’emballage (“Logiciel”), conformément aux clauses suivantes.

 

1. Point de départ

 

Ce contrat entre en vigueur dès l’ouverture de l’emballage du disque. La date de l’entrée en vigueur du présent con-
trat correspond donc au jour où vous ouvrez l’emballage du disque.

 

2. Propriété

 

La propriété et les droits d’auteur de ce Logiciel et de son logo, sa dénomination, son manuel et toute la documen-
tation qui l’accompagne appartiennent à Roland et au délivreur de la licence.
Les opérations suivantes sont interdites:

• Toute copie sans autorisation du Logiciel ou de tout fichier de support, module de programme ou documentation.
• Toute tentative de modification, de désassemblage, de décompilation ou toute autre manipulation visant à dé-

couvrir les codes sources du Logiciel.

 

3. Limites de la licence

 

Roland ne vous autorise pas à accorder la licence, louer, assigner ou transférer les droits accordés dans le cadre de 
ce contrat, ni le Logiciel même (y compris les accessoires fournis) à un tiers.
Toute utilisation du Logiciel via un système de partage et/ou réseau par des tiers ne détenant pas de licence indivi-
duelle pour ce Logiciel est interdite.
Le Logiciel peut être installé sur un seul ordinateur et utilisé par une seule personne.

 

4. Copie

 

Vous êtes autorisé à faire une seule copie du Logiciel, et ce exclusivement à titre de sauvegarde. Cette copie du 
logiciel est la propriété de Roland.
Vous pouvez installer le Logiciel sur le disque dur d’un seul ordinateur.

 

5. Résiliation

 

Roland se réserve le droit de résilier le présent contrat sans préavis dans les cas suivants:
• Lorsque vous violez toute clause du présent contrat.
• En cas de déloyauté de votre part dans le cadre du présent contrat.

 

6. Limites de responsabilité

 

Roland se réserve le droit de modifier les spécifications du présent Logiciel ou de sa documentation sans avis 
préalable.
Roland décline toute responsabilité pour tout dommage que pourrait provoquer l’utilisation de ce Logiciel ou 
l’exercice des droits découlant de ce contrat.

 

7. Juridiction compétente

 

Ce contrat est régi par le droit japonais. Tout litige est exclusivement du ressort des tribunaux japonais.

 

Contrat de licence Roland

R1–051220
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Avec Windows

 

• Le logiciel “Roland CutStudio” fourni permet de fabriquer des autocollants ou des caractères pour lettrage.
Voyez “Logiciels fournis” à la p. 11.

• Vous pouvez utiliser le plug-in fourni pour Adobe Illustrator, “CutStudio Plug-in for Adobe Illustrator”. Il permet 
de transmettre des données de découpe créées avec Illustrator à CutStudio pour fabriquer des autocollants et des 
caractères pour lettrage.
Voyez “Software plug-in overview, installation method” dans le document électronique “Windows Advanced 
Guide”.

 

Description

CutStudio

CutStudio

Vous pouvez déterminer la forme de l’autocollant. Voyez “Découpe” à la p. 14.

STIKA
Autocollant

Pour la réalisation d’autocollants imprimés, il vous faut le STIKA et une imprimante.
Voyez le document électronique “Windows Advanced Guide”.

STIKA Autocollant avec imageImprimante

Illustrator
+

CutStudio

Illustrator
+

CutStudio

Création d’autocollants avec des données Illustrator.
Voyez le document électronique “Windows Advanced Guide”.

STIKA Autocollant

Pour la réalisation d’autocollants imprimés, il vous faut le STIKA et une imprimante.
Voyez le document électronique “Windows Advanced Guide”.

STIKA
Autocollant avec 

imageImprimante
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• Vous pouvez utiliser le plug-in fourni pour CorelDRAW, “CutStudio Plug-in for CorelDRAW”. Il permet de trans-
mettre des données de découpe créées avec CorelDRAW à CutStudio pour fabriquer des autocollants et des carac-
tères pour lettrage. Voyez “Software plug-in overview, installation method” dans le document électronique 
“Windows Advanced Guide”.

• Le logiciel fourni “STIKA Navi” vous permet de régler les paramètres du STIKA sur ordinateur. L’interface utilisa-
teur du logiciel est très conviviale.
Voyez “STIKA Navi Overview” dans le document électronique “Windows Advanced Guide”.

 

Pour Macintosh

 

• Le plug-in “CutStudio Plug-in for Adobe Illustrator” vous permet de découper des objets créés avec Illustrator.
Voyez “Si vous utilisez un ordinateur Macintosh” à la p. 13.

CorelDRAW
+

CutStudio

Vous pouvez créer des autocollants avec des données CorelDRAW.
Voyez le document électronique “Windows Advanced Guide”.

STIKA Autocollant

Vous pouvez, par exemple, vérifiez s’il y a bourrage de papier.
Voyez le document électronique “Windows Advanced Guide”.

Fenêtre de fonctionnement STIKA Navi

STIKA

Vous pouvez utiliser des parties de support non utilisées pour créer de nouveaux objets.
Voyez le document électronique “Windows Advanced Guide”.

STIKA

Partie non utilisée

Cliquer

Fenêtre de fonctionnement STIKA Navi

Cliquer

Illustrator
+

CutStudio

Vous pouvez créer des autocollants avec des données Illustrator.
Voyez le document électronique “Macintosh Cutting Guide”.

STIKA Autocollant
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Messages AVERTISSEMENT et PRUDENCE

Symboles

 

•

 

N’ouvrez jamais le boîtier et n’apportez jamais de 

modifications à la machine.

 

Cela peut provoquer un incendie, une électrocution ou 
des blessures. Confiez les réparations à un technicien 
qualifié et agréé.

•

 

Evitez que des enfants ne viennent jouer à proximité la 

machine.

 

La machine contient des éléments pouvant provoquer des 
blessures. Celles-ci peuvent aller jusqu’à provoquer une 
cécité, un étouffement ou d’autres accidents graves.

•

 

Utilisez exclusivement les accessoires (consommables, 

adaptateur, cordon d’alimentation) recommandés 

expressément pour cette machine.

 

D’autres accessoires risquent d’entraîner un accident.

•

 

Branchez la machine à une prise secteur correspondant 

aux caractéristiques imprimées sur l’étiquette de modè-

le de la machine.

 

Une tension inadéquate ou un courant insuffisant risque 
de provoquer un incendie ou une électrocution.

•

 

Soyez prudent avec le cordon d’alimentation, la fiche et 

la prise secteur utilisée. Si un de ces éléments est 

endommagé, débranchez immédiatement la machine.

 

Cela peut provoquer un incendie, une électrocution ou 
des blessures.

•

 

Si vous utilisez une rallonge, elle doit correspondre aux 

caractéristiques imprimées sur l’étiquette de modèle.

 

Ne branchez en outre aucun autre appareil à consomma-
tion élevée sur ce circuit car cela peut provoquer un 
incendie.

•

 

Placez toujours la machine de sorte à offrir un accès 

immédiat au cordon d’alimentation.

 

En cas de problème, vous devez pouvoir débrancher 
immédiatement la prise d’alimentation. Placez la machi-
ne à côté d’une prise secteur. Laissez toutefois assez de 
place pour un accès immédiat au cordon.

•

 

Si vous remarquez une anomalie (fumée ou étincelles, 

odeur de brûlé, bruit inhabituel) durant l’utilisation, 

débranchez immédiatement le cordon d’alimentation. 

N’utilisez jamais de câble ou autre élément endomma-

gé.

 

Cela peut provoquer un incendie, une électrocution ou 
des blessures. Contactez directement votre revendeur Roland DG 
ou un service après-vente agréé.

•

 

Si vous n’avez pas l’intention d’utiliser la machine pen-

dant une période prolongée, débranchez-la du secteur.

 

Vous évitez ainsi des dommages ou accidents provoqués 
par une fuite ou un démarrage intempestif de la machine.

•

 

N’utilisez jamais la machine à l’extérieur ou à des 

endroits soumis à une forte humidité. ou, a fortiori, à la 

pluie ou des jets d’eau, Ne touchez jamais la machine 

avec des mains mouillées.

 

Cela peut provoquer un incendie ou une électrocution.

•

 

Ne laissez jamais tomber des objets comme des trombo-

nes, épingles à cheveux, pièces de monnaie, allumettes, 

etc. à l’intérieur de la machine. Ne renversez pas de 

liquide à l’intérieur de la machine.

 

Les pièces de monnaie, allumettes, liquides etc. parvenant 
à l’intérieur de la machine par les fentes d’aération ris-
quent de provoquer un incendie ou une électrocution. Dans ce cas, 
débranchez immédiatement le cordon d’alimentation et contactez 
un centre de S.A.V. Roland DG agréé.

 

Pour une utilisation en toute sécurité

 

 

 

AVERTISSEMENT

 

Ce message avertit l’utilisateur d’un danger de mort ou de blessure grave en cas de mauvaise 

utilisation de l’appareil.

 

 

PRUDENCE

 

Ce message appelle à la prudence car il y a risque de blessure ou de dommage matériel en cas 

de mauvaise utilisation de l’appareil.

* Les “dommages matériels” font référence aux dégâts ou à d’autres effets néfastes sur le lieu 

d’utilisation, le mobilier et d’éventuels animaux domestiques.

Le symbole en forme de triangle attire l’attention de l’utilisateur sur des instructions importantes ou des avertissements. 

Le sens précis du symbole est déterminé par le dessin à l’intérieur du triangle. Le symbole à gauche signifie “danger d’élec-

trocution”.

Ce symbole attire l’attention de l’utilisateur sur des procédures qu’il ne peut jamais effectuer (interdites). Le dessin à l’in-

térieur du cercle précise ce qu’il est interdit de faire. Le symbole à gauche signifie qu’il ne faut jamais tenter de démonter 

l’appareil.

Ce symbole indique les opérations qu’il faut effectuer. L’opération à effectuer est indiquée par un dessin à l’intérieur du 

cercle. Le symbole à gauche indique qu’il faut débrancher le cordon d’alimentation de la prise secteur.

ATTENTION

Etiquette de modèle
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•

 

Ne laissez jamais des enfants s’approcher de la machine. 

N’utilisez jamais d’aérosols combustibles à proximité 

de la machine. N’utilisez jamais la machine à des 

endroits où il y a accumulation de gaz.

 

Il y a risque d’incendie ou d’explosion.

•

 

Prudence: Outil de découpe.

 

Cette machine contient un outil. Veillez à ne pas vous 
blesser avec cet outil.

•

 

Avant de nettoyer la machine et les accessoires, 

débranchez le cordon d’alimentation.

 

Le non-respect de cette consigne peut entraîner une élec-
trocution ou d’éventuelles blessures.

•

 

Placez la machine sur une surface plane et stable.

 

Si vous installez la machine à un endroit inapproprié, elle 
peut causer un grave accident en tombant.

•

 

N’utilisez jamais cette machine à d’autres fins que celles 

pour lesquelles elle a été conçue. Evitez également tout 

usage excessivement intensif.

 

Cela risque de provoquer un incendie.

 

Cette machine est un appareil de précision. Pour en obtenir un rendement optimal, veuillez observer les consignes 
importantes ci-dessous. Le non-respect de ces consignes peut entraîner une baisse des performances voire un dys-
fonctionnement ou une panne de la machine.

 

Cette machine est un appareil de précision.

 

Maniez-la avec soin, ne la soumettez jamais à des chocs ou une force excessive.

 

Installez la machine à un endroit approprié

 

• Installez-la dans un lieu où la température et l’humidité ambiante sont conformes aux plages prescrites.
• Choisissez un lieu stable et offrant de bonnes conditions d’utilisation. Voyez “Choix du lieu d’installation” à la p. 9.

 

Remarque importante sur la connexion

 

Branchez correctement le cordon d’alimentation ainsi que les câbles de l’ordinateur (entrée, sortie). Voyez “Con-
nexion des câbles” à la p. 10.

 

Avant de déplacer la machine

 

Quand vous transportez la machine, prenez-la toujours par le bas avec les deux mains. Si vous portez la machine en 
la tenant ailleurs, vous risquez de l’endommager.

PRUDENCE

 

Remarques importantes sur le maniement et l’utilisation
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1-1 Eléments fournis

 

A la livraison, l’emballage doit contenir les éléments suivants. Assurez-vous qu’aucun élément ne manque.

 

1.  Préparations pour l’installation

Adaptateur secteur Câble d’alimentation Câble USB Garde de lame de 
rechange x 1

* La forme dépend du modèle.

Lame Cutter, poussoir
*Le cutter, la lame et le poussoirs 

sont déjà installés à la livraison.

Support de test (couleur) Feuille de transfert 
(transparente)

CD-ROM Mode d’emploi
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1-2 Nom des pièces

1-3 Emplacement de l’étiquette d’alimentation et du numéro de série

 

1-4 Retirer le matériel d’emballage

 

Pour le transport, la machine est dotée de film adhé-
sif et de diverses protections. Lorsque l’installation 
est terminée, enlevez-les.

 

Attention: 

 

Enlevez toutes les protections. La moindre pro-
tection oubliée peut entraîner un mauvais fonctionnement 
ou une panne à la mise en service.

 

1-5 Installation

 

Choix du lieu d’installation

 

Choisissez un lieu stable et offrant de bonnes condi-
tions d’utilisation. Un endroit non adéquat peut 
causer un accident, un incendie, des dysfonctionne-
ments ou des pannes.

 

Attention: 

 

N’utilisez jamais la machine à l’extérieur ou à 
des endroits soumis à une forte humidité. ou, a fortiori, à 
la pluie ou des jets d’eau, Ne touchez jamais la machine 
avec des mains mouillées. Cela peut provoquer un incen-
die ou une électrocution.

 

Attention: 

 

Ne laissez jamais des enfants s’approcher de la 
machine. N’utilisez jamais d’aérosols combustibles à 
proximité de la machine. N’utilisez jamais la machine à des 
endroits où il y a accumulation de gaz. Il y a risque d’incen-
die ou d’explosion.

 

Attention: 

 

Placez toujours la machine de sorte à offrir un 
accès immédiat au cordon d’alimentation. En cas de pro-
blème, vous devez pouvoir débrancher immédiatement la 

Rouleaux de maintien

Garde de la lame Cutter

* Levier de chargement

Couvercle de l’axe 
du chariot

Chariot de découpe

Prise pour adaptateur secteur

Connecteur USB

Bouton [POWER]

Témoin [POWER]

* Le SV-15 est doté de leviers de chargement à gau-
che et à droite. Le SV-12/SV-8 dispose d’un seul 
levier à droite.

Molette d’avance
du support

Numéro de série
Ce numéro vous sera demandé pour tout entretien, répa-
ration ou assistance technique. Ne décollez jamais cette 
étiquette et veillez à ce qu’elle reste toujours propre.

Etiquette d’alimentation
Utilisez exclusivement une prise secteur répondant aux 
spécifications de tension, de fréquence et d’ampérage 
imprimées ici.

Protection
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prise d’alimentation. Placez la machine à côté d’une prise 
secteur. Laissez toutefois assez de place pour un accès im-
médiat au cordon.

 

Attention: 

 

Placez la machine sur une surface plane et sta-
ble. Si vous installez la machine à un endroit inapproprié, 
elle peut causer un grave accident en tombant.

 

Endroits à éviter pour l’installation

 

• Endroits soumis à des vibrations
• Endroits où le sol est incliné, accidenté ou instable.
• Endroits poussiéreux
• Endroits exposés à des interférences électriques ou 

magnétiques considérables ou à d’autres formes 
d’énergie électromagnétiques

• dans des endroits qui ne permettent pas une dissipa-
tion suffisante de la chaleur.

 

Espace requis

 

1-6 Connexion des câbles

 

Attention: 

 

Branchez la machine à une prise secteur corres-
pondant aux caractéristiques imprimées sur l’étiquette de 
modèle de la machine. Une tension inadéquate ou un cou-
rant insuffisant risque de provoquer un incendie ou une 
électrocution.

 

Attention: 

 

Soyez prudent avec le cordon d’alimentation, la 
fiche et la prise secteur utilisée. Si un de ces éléments est 
endommagé, débranchez immédiatement la machine. 
Cela peut provoquer un incendie, une électrocution ou des 
blessures.

 

Attention: 

 

Si vous utilisez une rallonge, elle doit corres-
pondre aux caractéristiques imprimées sur l’étiquette de 
modèle. Ne branchez en outre aucun autre appareil à con-
sommation élevée sur ce circuit car cela peut provoquer un 
incendie.

 

Attention: 

 

Utilisez exclusivement un adaptateur et un cor-
don d’alimentation compatibles avec la machine. L’utilisa-
tion d’un autre adaptateur risque de provoquer un acci-
dent.

 

Branchez la machine à l’ordinateur avec le câble USB 
inclus.

 

Attention: 

 

Branchez le câble USB au moment indiqué du-
rant l’installation du pilote. Ne branchez jamais le câble 
USB avant d’avoir commencé l’installation du pilote car 
l’installation risque d’échouer et la machine peut devenir 
instable. Voyez “Installation du pilote” à la p. 12.

 

Attention: 

 

N’utilisez jamais de hub USB ou de dispositif 
similaire.

Le support avance et recule pendant la décou-
pe. Ne placez aucun objet devant ou derrière le 
support. Ne placez jamais la machine contre un 
mur ou dans un meuble.

Veillez à ce qu’aucun 
objet ne touche la mo-
lette d’avance du sup-
port.

Placez toujours la ma-
chine de sorte à offrir un 
accès immédiat au cor-
don d’alimentation.

Adaptateur 
secteur

Câble
d’alimentation

Prise pour adaptateur secteur

Câble USB
Etiquette d’alimentation

Attention: Ne branchez 
PAS ENCORE le câble 
USB.
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1-7 Installation des logiciels

 

Cette section explique comment installer les logiciels 
fournis.

 

Logiciels fournis

 

Le CD-ROM fourni contient les logiciels suivants.

 

Logiciels pour Windows

 

Pilote STIKA—

 

Ce pilote Windows est indispensable 
pour transmettre des données d’un ordinateur à la 
machine. N’oubliez pas de l’installer.

 

STIKA Navi—

 

Ce logiciel permet de télécommander 
la machine à partir de l’ordinateur. Il permet notam-
ment d’amener le cutter à l’endroit voulu et de tester 
l’avance du support. Ce logiciel est automatique-
ment installé avec le pilote STIKA.

 

Roland CutStudio—

 

“Roland CutStudio” est un lo-
giciel qui permet de créer des données de découpe et 
de découper les objets.

 

Plug-in CutStudio pour Adobe Illustrator—

 

Ce 
plug-in vous permet de découper des objets créés 
avec Adobe Illustrator.

 

Plug-in CutStudio pour CorelDRAW—

 

Ce plug-in 
vous permet de découper des objets créés avec Corel-
DRAW.

 

Logiciel pour Macintosh

 

Plug-in CutStudio pour Adobe Illustrator—

 

Ce 
plug-in vous permet de découper des objets créés 
avec Adobe Illustrator.

 

Si vous utilisez un ordinateur Windows

 

Système requis

 

Système requis pour la connexion USB
Pour qu’une connexion USB fonctionne avec Win-
dows, l’ordinateur doit répondre aux critères sui-
vants. Notez que toute autre configuration est in-
compatible.

Système requis pour Roland CutStudio

Système requis pour le pilote STIKA

 

Système d’ex-

ploitation

Windows 98 SE (Second Edition)/Me/2000/XP

Ordinateur 1) Ordinateur vendu avec Windows 98 SE/Me/

2000/XP (ou un ordinateur mis à jour ultérieu-

rement avec Windows 98 SE/Me/2000/XP).

2) Un modèle dont le fabricant garantit la 

communication USB.

Système d’ex-

ploitation

Windows 98 SE (Second Edition)/Me/2000/XP

Ordinateur Ordinateur tournant sous Windows

Lecteur Lecteur CD-ROM

Ecran Compatible Windows et permettant d’affi-

cher des couleurs 16 bits (High color) ou plus

Mémoire 

(RAM)

128MB ou plus

Espace disque 

dur disponible 

(pour l’installa-

tion)

10MB

Système d’ex-

ploitation

Windows 98 SE (Second Edition)/Me/2000/XP

Ordinateur 1) Ordinateur vendu avec Windows 98 SE/Me/

2000/XP (ou un ordinateur mis à jour ultérieu-

rement avec Windows 98 SE/Me/2000/XP).

2) Un modèle dont le fabricant garantit la 

communication USB.
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Installation du pilote

 

STIKA Navi est installé en même temps que le pilote.

 

Attention: 

 

Ne branchez la machine à l’ordinateur que 
quand vous y êtes expressément invité. Le non-respect de 
cette précaution pourrait rendre impossible l’installation 
du pilote. Voyez “Que faire en cas de problèmes…” à la 
p. 30.

 

A

 

Avant de commencer l’installation et la configura-

tion, assurez-vous que le câble USB n’est PAS bran-

ché.

 

B

 

Ouvrez une session dans Windows. Si vous utilisez 

Windows 2000/XP, ouvrez une session en choisissant 

un compte offrant des droits “Administrateurs”.

 

C

 

Insérez le CD-ROM fourni dans le lecteur de l’ordina-

teur.

 

Après un bref intervalle, le menu suivant apparaît.

 

D

 

Cliquez sur [Install].

 

Le “Installation and Setup Guide” apparaît. Si vous 
utilisez Windows 98 SE, Windows Me ou Windows 
2000, le “Installation and Setup Guide” ainsi que le 
programme “Setup” apparaît.

 

E

 

Suivez les instructions du “Installation and Setup 

Guide” pour effectuer l’installation.

Si la fenêtre “Driver Setup” ne s’affiche pas.

 

Si, sous Windows 98 SE, Windows Me ou Windows 
2000, le programme “Setup” n’apparaît pas, vérifiez 
la barre des tâches dans le bas de l’écran. Si 
[Driver Setup] est affiché, le programme tourne. Al-
lez sur la barre des tâches et cliquez sur 
[Driver Setup] pour afficher la fenêtre du program-
me “Setup”.

 

Installation de CutStudio

 

Installez le logiciel “CutStudio”.

 

A

 

Affichez le menu du logiciel (“Roland STIKA Softwa-

re Package”).

 

B

 

Cliquez sur [Install].

 

Suivez ensuite les instructions apparaissant à l’écran 
pour achever l’installation. Installez ensuite “Win-
dows Advanced Guide”.

 

Afficher l’aide en ligne de Roland CutStudio

 

Cliquez sur [Démarrer] puis pointez sur [Tous les 
programmes] (ou [Programme]) puis sur 
[Roland CutStudio] et enfin sur [CutStudio Help].

* Vous pouvez aussi afficher l’aide en ligne avec le 
menu de CutStudio.

 

Installer “Windows Advanced Guide”

 

A

 

Affichez le menu du logiciel (“Roland STIKA Softwa-

re Package”).

 

B

 

Cliquez sur [Install].

 

La fenêtre “Setup” apparaît. Suivez ensuite les ins-
tructions apparaissant à l’écran pour achever l’instal-
lation.

Cliquez sur 
[Install].

Cliquez ici.Barre des tâches

Cliquez sur 
[Install].
La fenêtre “Setup” 
apparaît.

Cliquez sur 
[Install].
La fenêtre “Setup” 
apparaît.
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CA la page du menu de configuration, cliquez sur [X] 

dans le coin supérieur droit de la fenêtre pour la fer-

mer.

Afficher le ‘Windows Advanced Guide’

Cliquez sur [Démarrer] puis pointez sur [Tous les 
programmes] (ou [Programme]) puis sur 
[Roland SV Series Manual] et enfin sur 
[Advanced Guide].

Installer le plug-in CutStudio
Pour en savoir plus sur l’installation du plug-in 
CutStudio, voyez le document électronique “Win-
dows Advanced Guide”.

Si vous utilisez un ordinateur Macintosh

Système requis
Branchez le STIKA à un Macintosh remplissant les 
conditions suivantes.
SYSTÈME D’EXPLOITATION: Mac OS 9 ou plus 
récent (les versions Adobe Illustrator 9/10/CS fonc-
tionnent parfaitement)

Installation des logiciels
Le CD-ROM fourni contient le “Mac OS Installation 
and Setup Guide” qui vous explique comment ins-
taller les logiciels et le Macintosh Cutting Guide. Si 
vous utilisez un Macintosh, suivez la procédure dé-
crite ci-dessous pour afficher le fichier puis suivez les 
explications pour l’installation.

A Insérez le CD-ROM fourni dans le lecteur de l’ordina-

teur.

B L’icône “Roland SV Series” apparaît sur le bureau. 

Double-cliquez sur cette icône.

CDouble-cliquez sur l’icône “Install_e.html”.

Le “Mac OS Installation and Setup Guide” apparaît.

Suivez ensuite les instructions du “Mac OS Installa-
tion and Setup Guide” pour installer le logiciel et le 
“Macintosh Cutting Guide”.
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Cette section décrit les opérations de base sous Windows. Pour les opérations non couvertes dans ce chapitre, 
veuillez consulter le manuel de format électronique “Windows Advanced Guide”.

2-1 Préliminaires

Types de supports reconnus

Vous pouvez utiliser les types de supports suivants avec la machine.

* Certains types de support ne peuvent pas être découpés avec cette machine.

N’utilisez jamais de support présentant les caractéristiques suivantes: Cela risque d’entraîner un bourrage de sup-
port.

• Support ondulé.
• Support dont le bord avant n’est pas droit.
• Support dont les bords gauche et droit sont irréguliers.
• Un support d’une longueur supérieure à 1100mm.

Utiliser un support en rouleau

Avec un support en rouleau, il faut prévoir une mar-
ge de plus de 40mm pour pouvoir couper le support 
du rouleau. La machine permet d’utiliser des sup-
ports d’une longueur maximum de 1100mm. Notez 
que la surface utile pour des objets est de 1000mm.

Attention: Veillez à découper le support à angle droit. Si la 
découpe n’est pas droite, le support peut ensuite rencon-
trer des problèmes d’avance. Il risque même de se libérer 
des rouleaux de maintien.

2-2 Découpe

Voyons comment créer puis découper l’objet sui-
vant.

Effectuez les opérations suivantes dans l’ordre indi-
qué.

2. Effectuer une découpe

SV-15 SV-12 SV-8

Dimensions • Largeur: 360~381mm; 280~305mm 

(Longueur: A3, Largeur: A4). 

Voyez “Changer la largeur du sup-

port (SV-15 uniquement)” à la 

p. 15.

• Longueur: 1100mm ou moins

• Largeur: 280~305mm (Longueur: 

A3, Largeur: A4)

• Longueur: 1100mm ou moins

• Largeur: 200~215mm (Longueur: 

A4)

• Longueur: 1100mm ou moins

Types de support* • Support en vinyle (épaisseur maximale: 0,1mm; épaisseur maximale avec couche inférieure: 0,3mm)

• Papier pour étiquettes (épaisseur maximale avec couche inférieure: 0,3mm)

Up to 

1100 mm  

(43-1/4 in.)

1100mm 
maximum
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Etape 1: Installer le support

AMettez la machine hors tension.

BVérifiez que la taille du support est adéquate et qu’il 

touche les rouleaux de maintien.

Attention: Vous pouvez faire coulisser les rouleaux de 
maintien du SV-15 en fonction de la largeur du support. 
Chargez ensuite le support. Voyez “Changer la largeur du 
support (SV-15 uniquement)” à la p. 15.

CAlignez le côté gauche du support pour qu’il soit pa-

rallèle au guide d’alignement.

Si ce n’est pas le cas, avancez le support vers l’inté-
rieur de façon à ce qu’il soit parallèle au guide et qu’il 
se trouve sous les rouleaux de maintien.

D Tournez la molette d’avance pour faire avancer da-

vantage le support dans la machine. Tournez ensuite 

la molette dans l’autre sens. Le support doit rester 

sous les rouleaux de maintien.

Si le support est chargé de travers ou semble quitter 
les rouleaux de maintien, chargez-le de nouveau.

E Lors du chargement du support, aidez-vous des mar-

ques à l’arrière de la garde de la lame.

Charger le support de test
La direction dans laquelle le support de test doit être 
chargé dépend du modèle de la machine.

SV-15/SV-12—  Dans le sens de la largeur (paysage)

SV-8— Dans le sens de la longueur (portrait)
Avec le modèle SV-15, réglez la largeur du support 
sur 280~305mm. Lisez la section suivante.

Changer la largeur du support (SV-15 uniquement)
Le SV-15 vous permet de régler la largeur du support 
sur 360~381mm ou 280~305mm. Pour régler la lar-
geur, décalez les rouleaux de maintien et réglez les 
paramètres du pilote.

A Relevez le levier de chargement droit.

B Retirez la butée des rouleaux de maintien.

Attention: Soyez prudent quand vous retirez la butée pour 
éviter de l’élargir. Si elle est trop ouverte, elle risque de se 
détacher quand vous la réinstallerez.

Rouleaux de maintien

Le support doit être parallèle aux rouleaux de maintien.

Guide d’alignement

Molette d’avance du support

Levier de chargement (droit)

Butée des rouleaux de maintien
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C Faites glisser le rouleau de maintien droit sur le bord 

du support et réinstallez la butée.

DAbaissez le levier de chargement du support droit.

EChargez le support.

Voyez “Etape 1: Installer le support” à la p. 15.

FChangez la zone de découpe du pilote en fonction du 

support chargé.

Lisez la section suivante.

Etape 2: Créer des données de découpe

Utilisez le logiciel “CutStudio” pour créer des don-
nées de découpe. Pour savoir comment travailler 
avec CutStudio, voyez l’aide en ligne du logiciel.
Attention: Si vous utilisez Windows 2000/XP, ouvrez une 
session avec privilèges “Administrateur”.

Lancez CutStudio.

ACliquez sur [Start].

BChoisissez [Tous les programmes] (ou 

[Programmes]), [Roland CutStudio] et cliquez sur 

[CutStudio].

Réglez la plage de découpe.

ACliquez sur [File] puis sur [Cutting Setup].

La fenêtre “Cutting Setup” apparaît.

B Sous [Name], indiquez le nom du modèle utilisé.

CCliquez sur [Properties].

Rouleau de maintien
280~305mm

Rouleau de maintien
360~381mm

Levier de chargement (droit)

280~305mm

360~381mm
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La fenêtre “Properties” apparaît.

DCliquez sur l’onglet [Size].

E Réglez la plage de découpe en fonction de la taille du 

support.

• Cliquez sur [ ] et réglez la largeur sur 250 ou 
340mm (SV-15 uniquement).
Attention: Si vous utilisez le support de test, choisissez 
“250mm”.
Attention: Vous ne pouvez pas modifier la largeur du sup-
port avec le SV-12/SV-8.

• Pour “Length”, choisissez toujours une valeur infé-
rieure à la longueur du support (il faut laisser une 
marge).
Voyez “Plage de découpe” à la p. 25.

FCliquez sur [OK].

GCliquez à nouveau sur [OK] pour refermer la fenêtre 

“Cutting Setup”.

La plage de découpe est réglée.

Insérez du texte et les formes que vous voulez découper.

A titre d’exemple, nous allons entrer le mot “SALE” 
et l’entourer d’un cadre pour faciliter son extraction.

ACliquez sur [ ].

BCliquez n’importe où dans la zone blanche et tapez 

“SALE”.

CCliquez sur [ ].

Autour du texte, des symboles  et ▼ apparaissent.

DVous pouvez changer la taille du texte en faisant glis-

ser les symboles  et ▼.

ECliquez sur [ ].

FDessinez un rectangle autour du texte “SALE”.

Cliquez sur le coin supérieur gauche et glissez vers le 
bas, à droite pour changer la taille.

GCliquez sur [ ].

Onglet [Size]

Plage de 
découpe

La zone blanche correspond à 
la plage de découpe. Tout 
texte ou motif situé hors de 
cette plage n’est pas découpé.

Cliquez puis faites glisser à la taille
voulue.
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Sélectionnez la zone contenant le texte et le rectan-
gle. Quand il est sélectionné, la ligne devient bleue. 
Décalez la position vers le haut de la fenêtre, près du 
point de départ.

HCliquez sur [Save].

La fenêtre “Save As” apparaît.

I Pour “Save in”, choisissez le dossier voulu.

JDonnez un nom au fichier et cliquez sur [Save].

Les données crées sont sauvegardées.

Remarque importante sur la sauvegarde des données
La plage de découpe choisie avec [File]>[Cutting Se-
tup]>[Properties] n’est pas sauvegardée. La prochai-
ne fois que vous importez des données, affichez le 
menu [Cutting Setup] et redéfinissez la plage de dé-
coupe.

Etape 3: Découpe

Avant de lancer la découpe, effectuez les opérations 
“Etape 1: Installer le support” (p. 15) et “Etape 2: 
Créer des données de découpe” (p. 16).

AAppuyez sur le bouton [POWER] pour mettre la ma-

chine sous tension.

Le témoin [POWER] clignote Le chariot se déplace 
alors vers la gauche. Quand le témoin reste allumé, la 
machine est prête pour la découpe.

BCliquez sur [Cutting].

CCliquez sur [OK].

L’ordinateur transmet les données et la découpe 
commence. Le texte “SALE” et le cadre sont dé-
coupés.

DAppuyez sur le bouton [POWER] pour mettre la ma-

chine hors tension.

Le témoin [POWER] doit être éteint.

Point de départ

Amenez le pointeur dans le texte. Quand le pointeur 
se transforme en croix, faites glisser l’ensemble en 
maintenant le bouton de la souris enfoncé.
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E Tournez la molette d’avance pour extraire le support 

de la machine.

Arrêter la découpe en cours

AAppuyez sur le bouton [POWER] pour mettre la ma-

chine hors tension.

BAppuyez de nouveau sur le bouton [POWER] pour re-

mettre la machine sous tension.

Le chariot de découpe se déplace alors vers la gauche.
Attention: Pour recommencer la découpe avec le même 
support, il faut d’abord le retirer puis le rechargez.
Attention: La découpe peut aussi être interrompue avec 
“STIKA Navi”. Pour en savoir plus, voyez le document 
électronique “Windows Advanced Guide”.

Etape 4: Appliquer l’objet découpé
Pour appliquer un objet découpé, il faut utiliser la 
feuille de transfert. Coupez un morceau de feuille de 
transfert de la taille de l’objet. Avant l’application, 
nettoyez convenablement la surface sur laquelle vous 
voulez appliquer l’objet pour enlever poussière et 
graisse.

A Retirez les parties de support superflues pour qu’il ne 

reste plus que le texte.

Pour enlever les petites particules de découpe, utili-
sez une pincette.

BCoupez un morceau de feuille de transfert de la taille 

de l’objet.

Couvrez l’objet découpé avec la feuille de transfert 
pour éviter qu’il ne reste de l’air puis transférez le 
support.
Attention: Vous pouvez transférer le support facilement 
en vous servant d’une raclette en caoutchouc ou de la par-
tie plate d’une règle pour appuyer sur l’objet découpé à tra-
vers la feuille de transfert.

C Posez l’objet découpé et la feuille de transfert contre la 

surface d’accueil et appuyez fort.

DAssurez-vous que l’objet est bien collé à la surface et 

détachez lentement la feuille de transfert.

Attention: S’il y a une bulle d’air entre la surface et l’objet 
collé, crevez-la avec une aiguille et appuyez sur l’objet pour 
extraire l’air.
L’objet est placé à l’endroit voulu.

Après la découpe
Transférez l’objet découpé aussi vite que possible sur 
la feuille de transfert puis sur la surface d’accueil. S’il 
y a de la poussière sur l’objet, la feuille de transfert 
risque de ne pas coller.

Feuille de transfert
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Ce chapitre explique comment régler l’avance de la 
lame, charger correctement le support et créer des 
données de découpe.

3-1 Optimiser les paramètres de 
découpe

Vérifier les paramètres de découpe
Pour obtenir un résultat optimal, effectuez un test de 
découpe pour vérifier le réglage des paramètres. Ce 
test est indispensable quand vous utilisez un nou-
veau type de support et pour le réglage de l’avance de 
la lame. 
Attention: Avant d’effectuer un test de découpe, chargez le 
support. Si vous l’oubliez, vous endommagerez la lame et 
la protection de la lame.
Attention: Ne déplacez pas le chariot de découpe à la main. 
Cela peut endommager la machine.
Attention: Ne touchez aucun élément mobile durant le 
fonctionnement de la machine. Cela peut entraîner des 
dysfonctionnements.

AChargez le support.

Voyez “Etape 1: Installer le support” à la p. 15.

BActionnez le bouton [POWER] (le témoin s’allume) et 

maintenez-le enfoncé au moins 2 secondes.

CDès que le chariot se déplace, vous pouvez relâcher le 

bouton.

La découpe commence à partir de la position actuelle 
de la lame. L’objet illustré ci-dessous est découpé.

Si vous voulez refaire un test de découpe, maintenez 
de nouveau le bouton [POWER] enfoncé plus de 2 
secondes. (Attendez cependant que la découpe en 
cours soit terminée.) Ce nouveau test est effectué à 
un endroit où il ne risque pas de chevaucher la pre-
mière découpe.

D Retirez les objets découpés et vérifiez-en la qualité.

La qualité de la découpe dépend de l’avance de la la-
me. Si l’objet du test ne se détache pas correctement, 
changez l’avance de la lame de la façon suivante. 
Voyez “Réglage de l’avance de la lame” plus bas.

La couche inférieure du support porte une légère trace 
de la lame,
ce qui indique une avance optimale de la lame. 
Aucune correction n’est nécessaire.

Le support ne se détache pas facilement de la couche 
inférieure.
La trace de la lame est imperceptible.
La découpe est irrégulière.

Augmentez l’avance de la lame.

La trace de la lame est trop profonde et découpe la 
couche inférieure.
La lame découpe la couche inférieure.
Le support se froisse durant la découpe.

Réduisez l’avance de la lame.

Réglage de l’avance de la lame
Attention: Ne touchez jamais la pointe de la lame car celle-
ci est très tranchante. Vous pourriez vous blesser.

AMettez la machine hors tension.

BDesserrez la vis et retirez le cutter.

3.  Fonctions du STIKA

2 secondes 
au moins

Avance de lame 
optimale

Avance de lame 
insuffisante

Avance de lame 
trop importante

Vis

Cutter
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C Réglez l’avance de la lame.

Tournez le capuchon de la lame dans la direction in-
diquée pour augmenter l’avance de la lame. Chaque 
cran correspond à 0,1mm.

D Soutenez la vis par le dessous et insérez le cutter.

E Serrez la vis.

Tirez doucement le cutter vers le haut pour vérifier 
qu’il est correctement maintenu.

F Effectuez le test de découpe et vérifiez la qualité en 

fonction du support.

Recommencez cette procédure jusqu’à ce que la qua-
lité de la découpe soit optimale. Voyez “Vérifier les 
paramètres de découpe” à la p. 20.

Estimation de l’avance de la lame
La formule suivante permet de calculer approximati-
vement l’avance de la lame.

* Astuce:

Si la lame a laissé des traces visibles sur la couche in-
férieure, la pression de la lame est parfaite.

3-2 Corriger le chargement du 
support
Si le support n’est pas bien chargé, il risque de glisser 
pendant la découpe. Vous pouvez relever le ou les le-
viers de chargement pour décaler le support.

A Relevez le levier de chargement.

B Faites avancer et reculer le support jusqu’à ce qu’il 

soit parallèle au guide d’alignement.

CAbaissez le levier de chargement pour caler le sup-

port.

0,1mm

La pointe de la lame est à peine 
visible.

Contact ferme

Soutenez la vis par 
le dessous.

Vis

Cutter

Avance de la 
lame

Epaisseur du 
support

Epaisseur de la 
couche inférieure= +

2

Cutter

Moitié de la cou-
che inférieure

Lame

Couche inférieure

Support

L’avance de la lame est 
environ égale à la pro-
fondeur de découpe.

Levier de 
chargement

Guide d’alignement
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3-3 Données de découpe

Créer des données de texte
Cette section explique comment régler la taille et la 
police du texte avec la fenêtre “Properties”.
CutStudio permet d’utiliser des polices “TrueType” 
et “OpenType” basées sur “TrueType”.

ACliquez sur [ ].

BCliquez à l’endroit où vous voulez entrer le texte.

CCliquez sur [Format]> [Font].

La fenêtre “Properties” apparaît.
Vous pouvez aussi afficher la fenêtre “Properties” de 
la façon suivante.

• Cliquez sur [Format]> [Properties].
• Cliquez avec le bouton droit de la souris et sélec-

tionnez [Properties] dans le menu qui apparaît.

DChangez la taille et la police du texte.

[1] Pour choisir une police, cliquez simplement sur [ ] sous “Font”. 
Sélectionnez ensuite la police.
[2] Pour changer la taille du texte, cliquez sur la case [Text Height] et 
entrez la valeur voulue. La largeur change proportionnellement à la 
hauteur choisie.

ECliquez sur [OK].

Le texte change en fonction de vos réglages.
Pour en savoir plus sur la fenêtre “Properties”, voyez 
l’aide en ligne de “Roland CutStudio”.

FCliquez sur [ ].

GDessinez un rectangle autour du texte.

Encadrez de préférence le texte pour faciliter son ex-
traction.
Si vous devez découper des caractères de petite taille, 
vous pouvez encadrer chaque caractère indivi-
duel.Cela vous permettra de les détacher plus aisé-
ment.

HCliquez sur [Save].

La fenêtre “Save As” apparaît.

IChoisissez le dossier voulu avec “Save in”.

JDonnez un nom au fichier et cliquez sur [Save].

Les données crées sont sauvegardées.
[2]

[1]

Faire 
glisser
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Importer des données BMP/JPG

CutStudio permet d’importer des fichiers de format 
BMP/JPG. Le contour de ces images est automati-
quement détecté et peut être découpé. Ne perdez pas 
de vue les conditions suivantes car tous les types de 
données ne peuvent pas être importés. Respectez les 
conditions suivantes lors de la création de données 
d’image pour CutStudio.

Conditions préalables à une bonne découpe
• Les couleurs ne peuvent pas se fondre l’une dans 

l’autre mais doivent être bien distinctes.
• Nous recommandons l’utilisation d’images en noir 

et blanc.
• Il vaut mieux éviter les photos car elles contiennent 

trop de niveaux de gris.

Choisissez toujours la résolution la plus élevée.
• La valeur optimale dépend de la complexité et de la 

structure de l’image.
• Les images de haute résolution sont plus volumineu-

ses et leur importation dans CutStudio prend plus de 
temps.

ACliquez sur [File] puis sur [Import].

La fenêtre “Import” apparaît.

B Sélectionnez le type de fichier.

CCliquez sur [Open].

Les données chargées sont affichées.

D Spécifiez les dimensions et la position de l’objet.

ECliquez sur [Object]> [Image Outline].

La fenêtre “Image Outline” apparaît.

FCliquez sur [Extract Contour Lines].

Le contour de l’image est détecté.
Attention: Ce contour est représenté par une ligne bleue.

GVérifiez que le contour est bon puis cliquez sur [OK].

Le contour de l’image est détecté.

Exemple de fichier adéquat
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Attention: Au besoin, vous pouvez utiliser l’outil “Object” 
pour corriger le contour. Pour en savoir plus sur l’utilisa-
tion de l’outil “Object”, voyez l’aide en ligne de “Roland 
CutStudio”.

Supprimer des parties de l’objet importé
Si l’objet comporte des parties superflues, vous pou-
vez les supprimer avec CutStudio.

A Sélectionnez le contour de l’objet.

BCliquez sur [Object]> [Break Polyline].

Les composants de l’objet sont séparés.

CCliquez sur la partie de l’objet à supprimer.

DCliquez sur [Edit]> [Delete].

La partie sélectionnée est effacée. Les autres données 
sont conservées.

E Sélectionnez toutes les parties restantes de l’objet en 

faisant glisser la souris dessus.

Pour sélectionner tout le contenu de la fenêtre 
“CutStudio”, cliquez sur [Edit]> [Select All]. Vous 
pouvez aussi procéder en maintenant la touche [Ma-
juscule] enfoncée tout en cliquant sur les parties 
voulues.

FCliquez sur [Object]> [Integrate Polylines].

Les différentes parties sont rassemblées en un seul 
objet.

Outil “Object”
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3-4 Plage de découpe

Une marge est toujours ajoutée pour l’avance du support.

Largeur de découpe Longueur de découpe Largeur de support 

acceptable

Longueur de support 

acceptable

SV-15 340mm

250mm

1000mm

1000mm

360~381mm

280~305mm

1100mm

1100mm

SV-12 250mm 1000mm 280~305mm 1100mm

SV-8 160mm 1000mm 200~215mm 1100mm

SV-15: SV-12/SV-8:

Rouleaux de 
maintien

Largeur de découpe: 250mm

Largeur de support acceptable: 

280~305mm

Largeur de découpe: 340mm

Largeur de support acceptable: 360~381mm

Largeur de découpe:

SV-12: 250mm

SV-8: 160mm

Largeur de support acceptable:

SV-12: 280~305mm

SV-8: 200~215mm

Plage de 
découpe

Plage de 
découpe
Plage de 
découpe

Cutter

SupportSupport

Cutter

Rouleaux de maintien

Marge: 10mm Marge: 10mm
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3-5 Pose d’objets de grande taille
Plus l’objet est grand et plus il est difficile à aligner et 
à poser sur la surface voulue. En outre, pour un objet 
de grande taille, vous avez plus de risque d’obtenir 
des bulles d’air entre l’objet et la surface d’accueil.
Pour minimiser la présence de bulles d’air, nous 
vous recommandons de nettoyer la surface d’accueil 
avec un mélange d’eau et de détergent doux.

A Préparez l’objet découpé et recouvrez-le avec la feuille 

de transfert.

B Eliminez toute trace de poussière ou de saleté sur la 

surface d’accueil.

Pulvérisez un peu d’eau avec un peu (2~3 gouttes) de 
détergent neutre sur la surface.

C Placez l’objet avec précaution sur la surface d’accueil 

et positionnez-le convenablement.

D Eliminez toute l’eau restante avec une raclette.

EAttendez que l’eau se soit évaporée et enlevez ensuite 

la feuille de transfert.
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4-1 Nettoyage

Cette section explique comment nettoyer la machine 
et remplacer la lame.
Attention: Avant de nettoyer la machine, coupez l’alimen-
tation et enlevez tout reste de support.

Nettoyer la lame
Attention: Ne touchez jamais la pointe de la lame car celle-
ci est très tranchante. Vous pourriez vous blesser.
Si des restes de découpes ou de bande adhésive sont 
collés sur la lame, celle-ci perd son efficacité. Enlevez 
soigneusement les restes de support.

Nettoyer le cutter
Attention: Ne touchez jamais la pointe de la lame car celle-
ci est très tranchante. Vous pourriez vous blesser.
Si de la saleté ou des restes de découpe se sont accu-
mulés dans le capuchon du cutter, les performances 
de découpe risquent de s’en ressentir.
Ouvrez le cutter et retirez les résidus qui s’y trouvent.

Nettoyer la machine
Nettoyez le boîtier avec un chiffon sec. N’utilisez ja-
mais de solvant comme du dissolvant ou du benzène.

4-2 Lubrification de l’axe du chariot
S’il y a de la poussière ou des restes de support col-
lants sur l’axe du chariot, la qualité de la découpe ris-
que de baisser. Dans les cas suivants, retirez le cou-
vercle de l’axe de chariot et lubrifiez l’axe de la façon 
illustrée. Utilisez de l’huile de machine.

ADébranchez le câble d’alimentation de la prise.

B Enlevez le couvercle de l’axe du chariot.

Retirez les vis avec un tournevis en croix.

4.  Entretien

Tournez le capuchon de la 
lame dans la direction indi-
quée pour extraire la lame.

Mouvements irréguliers

Bruit anormal
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CNettoyez la poussière et les restes de support collant 

sur l’axe.

DAjoutez un peu d’huile de machine à l’endroit indiqué 

dans l’illustration.

Attention: N’utilisez pas trop d’huile sinon elle risque de 
couler sur le support. 

E Remontez le couvercle de l’axe du chariot et vissez-la.

4-3 Remplacement des consom-
mables

Remplacement de la lame
Quand la lame s’émousse ou est endommagée, rem-
placez-la. Ce remplacement est indispensable quand 
il est impossible d’obtenir une bonne découpe alors 
que l’avance de la lame est bien réglée. Installez une 
nouvelle lame.
Avant de remplacer la lame, retirez le support.
Attention: Ne touchez jamais la pointe de la lame car celle-
ci est très tranchante. Vous pourriez vous blesser.

ADébranchez le câble d’alimentation de la prise.

BDesserrez la vis et retirez le cutter.

C Enfoncez le poussoir jusqu’à ce que la lame glisse hors 

du cutter.

Enfoncez le poussoir jusqu’à ce qu’il ne soit plus vi-
sible.

D Insérez la nouvelle lame dans le cutter jusqu’à ce 

qu’un déclic audible se produise.

Le poussoir est éjecté.

E Soutenez la vis par le dessous et insérez le cutter.

Vis

Cutter

Lame usée

Poussoir

Nouvelle lame

Contact ferme

Soutenez la vis par 
le dessous.
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F Serrez la vis.

Tirez doucement le cutter vers le haut pour vérifier 
qu’il est correctement maintenu.

Remplacer la garde de la lame
Examinez régulièrement la garde de la lame: de légè-
res griffes ne posent pas de problème. En revanche, si 
elle est fortement endommagée, il faut la remplacer 
par la garde de réserve.
Attention: Le couteau utilisé pour cette opération est tran-
chant et potentiellement dangereux. Travaillez donc pru-
demment pour éviter les blessures.

ADébranchez le câble d’alimentation de la prise.

B Retirez la garde de la lame en vous aidant d’un cutter 

à tapis disponible dans le commerce.

Nous vous conseillons alors d’utiliser un cutter dis-
ponible dans le commerce. Si vous effectuez cette 
opération sur le SV-15, relevez les deux leviers de 
chargement.

C Enlevez tous les restes de colle de la machine.

Effectuez le nettoyage avec un chiffon.

D Posez la nouvelle garde de la lame

E en l’alignant sur la ligne de référence.

F Enlevez l’adhésif double-face et fixez la garde de la la-

me.

Si vous utilisez le SV-15, abaissez les leviers de char-
gement du support.

Vis

Cutter

Attention: Veillez à ne jamais mettre la main dans 
le champ du cutter pendant cette opération.

Ligne de référence

Leviers de chargement
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5-1 Que faire en cas de problèmes…

Cette section explique ce que vous pouvez faire si 
vous rencontrez un problème. Veuillez lire ce qui 
suit avant de conclure à une panne. Pour résoudre 
des problèmes non repris ci-dessous, veuillez consul-
ter le document électronique “Windows Advanced 
Guide” ou “Macintosh Cutting Guide”. Veuillez le 
consulter si nécessaire.

La machine ne fonctionne pas correctement.
Les câbles sont-ils correctement branchés?
Si le cordon d’alimentation ou le câble USB n’est pas 
branché correctement, refaites la connexion. Voyez 
“Connexion des câbles” à la p. 10.

Les réglages du pilote sont-ils corrects?
Avez-vous choisi le port de communication correct?

Le témoin d’alimentation clignote-t-il?
Une erreur de communication ou de commande 
s’est produite. Mettez l’appareil hors tension et vé-
rifiez les connexions et les réglages de port du pilote.

Une pression sur le bouton [POWER] ne coupe pas com-
plètement l’alimentation de la machine.
Pour cela, il faut débrancher l’adaptateur secteur de 
la prise de courant.

La découpe n’est pas nette.
L’avance de la lame est-elle correctement réglée?
Corrigez-la au besoin. Voyez “Réglage de l’avance de 
la lame” à la p. 20.

Avez-vous correctement installé la lame et le cutter?
Serrez bien la vis pour éviter qu’elle ne se desserre pas 
durant le fonctionnement.

La pointe de la lame est-elle cassée?
Installez une nouvelle lame. Voyez p. 28.

Les découpes ne sont pas continues.
La pointe de la lame est-elle cassée?
Installez une nouvelle lame. Voyez p. 28.

La pointe de la lame est-elle sale?
Retirez la lame et nettoyez-la. Voyez “Nettoyer la la-
me” à la p. 27.

Il y a-t-il une accumulation de résidus de support ou de 
poussière dans le cutter?
Ouvrez le cutter et retirez les résidus qui s’y trouvent. 
Voyez “Nettoyer le cutter” à la p. 27.

La garde de la lame est-elle très griffée?
Si la garde de la lame est endommagée, la découpe ne 
se fera pas convenablement, même si les réglages de 
la machine ainsi que l’installation de la lame et du 
cutter sont corrects. Changez la garde de la lame. 
Voyez p. 29.

Le cutter est-il usé ou endommagé?
Dans ce cas, remplacez-le.

La position de découpe est décalée vers le haut 
ou le bas.

L’avance de la lame est-elle correctement réglée?
Corrigez-la au besoin. Voyez “Réglage de l’avance de 
la lame” à la p. 20.

L’avance du support a-t-elle été bloquée?
Ne placez aucun objet devant ou derrière le support. 
Cela entraîne une avance irrégulière du support et 
un décalage du point d’origine.

La position de découpe est décalée vers la gau-
che/droite

Si la position de la découpe est décalée de la façon il-
lustrée, vérifiez les points suivants.

L’avance de la lame est-elle correctement réglée?
Corrigez-la au besoin. Voyez “Réglage de l’avance de 
la lame” à la p. 20.

Le chariot se déplace-t-il anormalement et entendez-
vous un bruit bizarre?
Enlevez tous les restes de support et autres poussières 
de l’axe du chariot et lubrifiez-le. Voyez “Lubrifica-
tion de l’axe du chariot” à la p. 27.

5.  Appendice

La distance entre 
les lettres n’est 
pas identique.

La découpe est 
décalée latérale-
ment
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Le support glisse durant la découpe.
Le support est-il d’une longueur supérieure à 500mm?
Un support d’une longueur supérieure à 500mm 
peut glisser. Dans ce cas, rechargez le support ou uti-
lisez un support d’autre format.

Le support est-il trop court?
Un support court et peu rigide peut glisser durant la 
découpe. Utilisez un autre type de support ou un 
support plus long.

Les bords du support sont-ils droits?
Si les bords du support ne sont pas droits, coupez-les 
pour qu’ils restent parallèles aux guides d’aligne-
ment.

L’avance du support a-t-elle été bloquée?
Utilisez un support d’une largeur adéquate. Assurez-
vous que le support ne touche pas les surfaces inter-
nes de la machine durant la découpe. Cela risquerait 
d’entraver l’avance et d’endommager le support.

Le support est-il gondolé ou froissé?
Cela peut entraîner une avance irrégulière du sup-
port et un glissement du support. Coupez la partie 
gondolée ou froissée du support et chargez-le de 
nouveau.

Que faire si vous n’arrivez pas à installer le pilote?
Si l’installation en cours s’arrête soudain ou la fenê-
tre Assistant ne s’affiche pas quand vous branchez la 
machine à l’ordinateur avec un câble USB, procédez 
comme suit:

A Si la fenêtre “Assistant Matériel détecté” apparaît, cli-

quez sur [Terminer] pour la refermer.

BAffichez la fenêtre “Propriétés système”.

Windows XP

Cliquez sur le menu [Démarrer] puis cliquez avec le 

bouton droit de la souris sur [Poste de travail]. Cli-

quez sur [Propriétés].

Windows 2000

Cliquez avec le bouton droit de la souris sur l’icône 

[Poste de travail] du bureau. Cliquez sur [Propriétés].

CCliquez sur l’onglet “Matériel” puis sur [Gestionnaire 

de périphériques].

La fenêtre “Gestionnaire de périphériques” s’affiche. 
Effacez l’icône du modèle (ou “Périphérique incon-
nu”).

D Sous le menu “Afficher”, cliquez sur [Afficher les pé-

riphériques cachés].

EDans la liste, cherchez le dossier “Imprimantes” ou 

“Autre périphérique” et double-cliquez dessus.

FCliquez sur l’icône du modèle (ou “Périphérique in-

connu”).

GChoisissez l’option [Désinstaller] sous le menu 

[Action].

L’affichage suivant apparaît à l’écran.

HCliquez sur [OK].

I Refermez la fenêtre “Gestionnaire de périphériques” 

et cliquez sur [OK].

JDébranchez le câble USB de l’ordinateur.

K Redémarrez Windows. Voyez ensuite “Désinstaller le 

pilote”.

L Recommencez l’installation depuis le début. Voyez 

“Installation du pilote” à la p. 12.
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Windows 98 SE/Me

AVoyez “Désinstaller le pilote” ci-dessous.

B Recommencez l’installation depuis le début. Voyez 

“Installation du pilote” à la p. 12.

Désinstaller le pilote
Voici comment désinstaller le pilote:
Attention: Avant de commencer la désinstallation du pilo-
te, débranchez le câble USB de l’ordinateur.

AOuvrez une session dans Windows. Si vous utilisez 

Windows 2000/XP, ouvrez une session en choisissant 

un compte offrant des droits “Administrateurs”.

B Insérez le CD-ROM fourni dans le lecteur de l’ordina-

teur.

Cliquez sur [X] dans le coin supérieur droit de la fe-
nêtre pour la fermer.

CCliquez sur le menu [Démarrer] puis sur [Exécuter].

D Entrez les informations données ci-dessous puis cli-

quez sur [OK].

Windows 2000/XP

(Lettre du lecteur CD-ROM):\Dri-
vers\WIN2KXP\SETUP.EXE

Windows 98 SE/Me

(Lettre du lecteur CD-ROM):\Drivers\WIN9X\Se-
tup.exe

E Le programme de configuration (“Setup”) démarre et 

la fenêtre “Driver Setup” apparaît.

FCliquez sur [Uninstall].

G Sélectionnez le modèle utilisé.

HCliquez sur [Démarrer].

ICliquez sur [Oui] pour redémarrer l’ordinateur.

Dans cet exemple, le CD-ROM est le lecteur 
“D”.



Mode d’emploi Remplacement des consommables

33

5-2 Fiche technique

*Si la longueur du support dépasse 500mm, il risque de glisser et d’entraver la découpe.
**Certains types de supports ne peuvent pas être utilisés avec cette machine.

SV-15 SV-12 SV-8

Procédé de découpe Avance du support

Plage de découpe maximum Largeur: 340mm

Longueur: 1000mm

Largeur: 250mm

Longueur: 1000mm

Largeur: 160mm

Longueur: 1000mm

Tailles de support utilisables (*) Largeur: 360~381mm

Longueur: 1100mm ou moins

Largeur: 280~305mm

(Longueur: A3, Largeur: A4)

Longueur: 1100mm ou moins

Largeur: 280~305mm

(Longueur: A3, Largeur: A4)

Longueur: 1100mm

Largeur: 200~215mm

(Longueur: A4)

Longueur: 1100mm ou moins

Vitesse de découpe 12~100mm/seconde 12~40mm/seconde 12~40mm/seconde

Types de support utilisables (**) Support en vinyle (épaisseur maximale: 0,1mm;

épaisseur maximale avec couche inférieure: 0,3mm)

Papier pour étiquettes (épaisseur maximale avec couche inférieure: 0,3mm)

Interface USB 1.1

Alimentation Prise pour adaptateur secteur: AC100V ±10%, 50/60Hz; 1,7A

Sortie: DC 19V, 2.1A

Consommation ±20W (adaptateur compris)

Dimensions (L x P x H) 522 x 205 x 115 mm 440 x 205 x 115 mm 340 x 205 x 115 mm

Poids 3,3kg 2,7kg 2,2kg

Niveau de bruit 60dB(A) ou moins (conforme à la norme ISO7779)

Système requis Température: 5~40˚C, humidité: 35~80% (sans condensation)

Eléments fournis Voyez p. 8.
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